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THE OPEN UNIVERSITY OF KENYA

DESIGN PLAN

The Design Plan presented below reflects the CUE suggested Plan but goes beyond that to specify how each outcome will be handled. All modules are based on this Design Plan.
Note: The principle of constructive alignment informs this Design Plan.


	Programme title
	BACHELOR OF TECHNOLOGY EDUCATION

	Course title
	CIT 122 Computer Applications

	Learning Module number
	CIT 122-02

	Learning module title
	Advanced Text Formatting in Word Processor

	Module Developer
	Dr. Mary Mwadulo

	Module duration in hours
	6 Hours

	Instructional Hour Equivalent (Divide duration by 2)
	

	Reviewed by
	

	Vision
	The innovative university for inclusive prosperity

	Audience description
	This module is designed for beginners who want to learn formatting techniques using a word processing. It will provide step-by-step guidance on how to format a document using word processing software, along with practical tips and techniques for creating professional-looking documents efficiently. Whether you're a student, office worker, or just someone who wants to improve their computer skills, this module will help you gain confidence in using word processing software and enhance your productivity.

	Instructions to learners
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	Designer:Provide an audio with  the followed prerecorded informations 
Welcome to Advanced text Formatting in Word Processor module! As your facilitator, I'm here to guide you through this learning experience.
Here are some instructions to help you get started:
1. Familiarize yourself with the course materials: Ensure you understand what you'll be studying in this module, what the learning outcomes are, and how the course is structured.
2. Manage your time effectively: Set aside a specific amount of time each day or week to work on this module. Make a schedule that works for you, and stick to it as much as possible.
3. Stay organized: Keep track of your progress by taking notes, using a planner, or using an online tool to keep track of your assignments and deadlines.
4. Participate in the online discussions: Take advantage of any online forums or discussion boards that are available to you. Engage with your fellow learners, ask questions, and share your own experiences and insights.
5. Complete all assignments: Make sure you complete all the assignments and quizzes associated with this module. This will help you reinforce what you've learned and prepare you for any assessments that may be required.
6. Seek help when needed: If you're struggling with any part of the module, don't hesitate to reach out to your facilitator or the support team for help. They're there to assist you and help you succeed.

Remember, learning is a process, and everyone learns at their own pace. Don't be discouraged if you encounter challenges along the way. With persistence and effort, you can master the material and achieve your learning goals.

 Good luck!


	Learning module description
	This module is designed to provide beginners with a solid foundation in word processing. Participants will learn the essential skills needed format a document using word processing software. The module will cover the basics of popular word processing software such as Microsoft Word, Google Docs, or similar applications.
Teaching Methodology
· Step-by-step demonstrations and tutorials for using word processing software.
· Hands-on practice exercises to reinforce learning.
· Real-world examples and scenarios to illustrate practical applications.
· Interactive discussions and Q&A sessions to clarify concepts.
· Supplemental resources, such as cheat sheets and quick reference guides, for further learning.
Target Audience
· Beginner-level computer users with little or no experience in word processing.
· Office workers, students, educators, administrative staff, or anyone who needs to create written documents for personal or professional purposes.
· Individuals who want to improve their computer skills, increase their productivity, and create professional-looking documents efficiently.
Duration
· The module can be completed in approximately 6 hours, depending on the pace of the learners and the depth of content covered.


	Module objectives:

	The module seeks to facilitate learning about:

1. Formatting tools such as styles, themes, and templates, page numbering, headers and footers, adding Table of content and apply them to create professional-looking documents.
2. The principles of document design, including typography, color, and layout, and apply them to create visually appealing documents.
3. Advanced formatting tools and applying document design principles to create visually appealing and professional documents.
4. Skills in visual communication, attention to detail, and creativity through designing visually appealing documents that effectively convey information.

	Module learning outcomes:


	By the end of the module  you should be able to:

5. Describe formatting tools such as styles, themes, and templates, page numbering, headers and footers, adding Table of content and apply them to create professional-looking documents.
1. Apply the principles of document design, including typography, color, and layout, and apply them to create visually appealing documents.
2. Develop skills in using advanced formatting tools and applying document design principles to create visually appealing and professional documents.
3. Develop skills in visual communication, attention to detail, and creativity through designing visually appealing documents that effectively convey information.


	Planned Learning Resources
	A Computer, course modules, online based materials, virtual lab, recorded lecturers, assessment tools, online videos, case studies, LMS, eBooks, books, interactive quizzes, Smart phones, virtual tools such as Zoom , google meet

	ACTIVITY 1: INTRODUCTION
VIDEO 1: Pre-recorded lecture on topic emphasizing LEARNING OUTCOME 1:
 Factual knowledge.
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	Designer: Provide a video with  the following prerecorded information

Text formatting tools
1. Page Numbering: Page numbering is an essential element of professional documents, providing readers with a convenient way to navigate through the document.
a. To add page numbers, go to the Insert tab and click on the Page Number button in the Header & Footer group.
b. Choose the desired location for the page numbers, such as top, bottom, or margins, and select a formatting option from the gallery.
c. Word automatically inserts the page numbers in the selected format, and they will be applied to all pages in the document by default.
Page numbers can be customized further by modifying the formatting, alignment, and other options in the Page Number Format dialog box.
2. Headers and Footers: Headers and footers are sections of a document that appear at the top (header) and bottom (footer) of each page, providing consistent information throughout the document, such as titles, authors, dates, and page numbers.
a. To add headers and footers, go to the Insert tab and click on the Header or Footer button in the Header & Footer group.
b. Choose a pre-designed header or footer from the gallery, or select Edit Header or Edit Footer to create a custom header or footer.
c. In the header or footer, you can insert text, images, and other elements, and format them using the tools in the Header & Footer Design tab that appears when the header or footer is active.
d. You can also link headers and footers to previous or subsequent sections, and customize them for different sections of the document, such as the first page, odd or even pages, and specific sections.
3. Table of Contents: A table of contents is a helpful tool for readers to quickly navigate through a document and locate specific sections or chapters.
a. To create a table of contents, place the cursor at the desired location in the document where the table of contents will be inserted.
b. Go to the References tab and click on the Table of Contents button in the Table of Contents group.
c. Choose a pre-designed table of contents style from the gallery, or select Insert Table of Contents to customize the formatting and other options.
d. Word automatically scans the document and generates the table of contents based on the headings and other styles applied to the document.
e. You can update the table of contents automatically if you make changes to the headings or other elements in the document, and you can customize the appearance of the table of contents using the tools in the Table of Contents tab that appears when the table of contents is active.

4. Styles: Styles in Microsoft Word allow you to apply consistent formatting throughout your document. You can create custom styles or use built-in styles. Here are some key points about styles:
a. Styles define the font, size, color, spacing, and other formatting attributes for text.
b. Styles can be applied to paragraphs, headings, titles, and other elements in your document.
c. Styles can be modified, updated, or deleted to maintain consistency in formatting.
d. Styles can be used to create a table of contents, generate a list of figures or tables, and apply formatting changes to multiple sections of a document at once.
5. Themes: Themes in Microsoft Word are sets of coordinated fonts, colors, and effects that can be applied to your entire document. Here are some important notes about themes:
e. Themes provide a unified and professional look to your document.
f. Themes can be applied to a document with just a few clicks, and they can be easily customized to suit your needs.
g. Themes can include predefined font sets, color schemes, and visual effects that can be applied to text, shapes, and images in your document.
h. Themes can be used to create visually appealing documents, such as brochures, flyers, and reports, with consistent formatting throughout.
6. Templates: Templates in Microsoft Word are pre-designed documents that can be used as a starting point for creating new documents. Here are some key points about templates:
i. Templates can save time and effort by providing pre-designed layouts, formatting, and content for specific types of documents, such as resumes, letters, and newsletters.
j. Templates can be customized with your own content, and you can create your own templates to reuse in the future.
k. Templates can include styles, themes, and other formatting tools to ensure consistency in your documents.
l. Templates can be downloaded from the Microsoft Office website, or you can create your own templates based on your specific needs.

In conclusion, page numbering, inserting TOC, headers and footers styles, themes, and templates are powerful formatting tools in Microsoft Word that can help you create professional-looking documents with consistent formatting throughout. They can save time and effort, ensure consistency, and enhance the visual appeal of your documents.


	
	Click the link below to watch the two videos Advanced Text formatting Write your own notes to summarize what you have watched. This notes will guide you in responding to  the questions that follow.

Video 1
Title: How To Work With Microsoft Word Themes Style Sets Tutorial
Video Link: https://youtu.be/TBdvWVGux3Y
Source: ClayDesk E-learning
Time taken to watch the video (minutes: seconds): 8:07

Video 2
Title: How to Create a Template in Word: Creating Templates in Word
Video Link: https://youtu.be/qs2HzP9Q9eg
Source: Simon Sez IT
Time taken to watch the video (minutes: seconds): 12:58

Video 3
Title: Word 2013: Headers, Footers, and Page Numbers
Video Link: https://youtu.be/BU6tOwzWtY8
Source: GCFLearnFree
Time taken to watch the video (minutes: seconds): 4:54

Video 4
Title: How to create a table of content in Ms Word 
Video Link: https://youtu.be/Se98M9lBxoU
Source: TheLifeofawriter
Time taken to watch the video (minutes: seconds): 1:15



	ACTIVITY 2: READING
READING MATERIAL 1
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	. Access the reading material below and read on advanced text formatting tools will guide you in answering the questions that follow.


Title: Headers and Footers
Link: http://www2.westsussex.gov.uk/LearningandDevelopment/IT%20Learning%20Guides/Microsoft%20Word%202010%20-%20Level%202/13%20Headers%20and%20footers.pdf


Title: Creating a table of content quickly in Ms Word
Link: https://images.template.net/wp-content/uploads/2016/03/21094329/Creating-A-Table-Of-Content-Quickly-In-Word.pdf

Title: Word 2013 & 2016: Templates and styles, the basics.
Link: https://gov.texas.gov/uploads/files/organization/disabilities/05_TemplStyles.pdf



Designer: avail the reading materials for the learner

	ACTIVITY 3:  Comprehension questions:
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	1. Having watched the videos and read the material on  page numbering, header and footer, Table of content, styles, themes and templates, attempt ALL of the following multiple choice questions. 
2. You are expected to get at least eight questions correct in order to proceed to the next activity.
3. This Activity will be graded

Questions
1. Which feature in Microsoft Word allows you to create consistent formatting throughout your document, including font, spacing, and paragraph alignment?
a.  Page Numbering 
b. Headers and Footers
c. Styles
d. Templates
2. How can you add a table of contents in Microsoft Word?
a. Insert > Table of Contents
b. Format > Table of Contents 
c. Page Layout > Table of Contents 
d. Review > Table of Contents
3. What is the purpose of using headers and footers in Microsoft Word?
a. To add page numbers and dates to your document
b. To change the font and color of your document
c. To insert tables and charts into your document
d. To add comments and track changes in your document
4. Which feature in Microsoft Word allows you to apply a consistent set of formatting options, including font, color, and spacing, to your entire document?
a. Styles
b. Themes
c. Templates
d. Page Numbering
5. Which feature in Microsoft Word allows you to save a collection of formatting options as a reusable design that can be applied to multiple documents? 
a. Page Numbering
b. Styles
c. Themes
d. Templates
6. What is the purpose of using themes in Microsoft Word?
a. To add page numbers and dates to your document
b. To change the font and color of your document
c. To insert tables and charts into your document 
d. To apply a consistent set of formatting options to your document
7. Which feature in Microsoft Word allows you to create a pre-designed layout for your document with predefined font, color, and formatting options?
a. Styles
b. Themes
c. Templates
d. Page Numbering
8. What is the purpose of using styles in Microsoft Word?
a. To add page numbers and dates to your document
b. To change the font and color of your document
c. To insert tables and charts into your document
d. To apply consistent formatting options to different parts of your document
9. What is a theme in Microsoft Word?
a. A way to change the font of text in a document 
b. A way to apply a set of formatting options to text in a document
c. A way to add images and graphics to a document
d. A way to apply a consistent look and feel to a document
10. What is the purpose of a header in Microsoft Word? 
a. To add page numbers and other information to every page
b. To change the font and formatting of a document
c. To add images and graphics to a document
d. To create a table of contents



Designer: What is highlighted in red is the correct answer. Each question carries one point. If a learner does not get atleast eight correct answers then the learner should be referred back to watch the videos and re read the book chapter


	LEARNING OUTCOME 2: Conceptual knowledge


ACTIVITY 4: Video to be used.

	1. Click the link below to watch the two videos on document design and apply them to create visually appealing documents.
2.  Write your own notes to summarize what you have watched. This notes will guide you in responding to the questions that follow.
Video 1
Title: Make Awesome Page Layout Designs in Microsoft Word
Video Link: https://youtu.be/GnqCD9_BuWE
Source: Evato Tuts+
Time taken to watch the video (minutes: seconds): 6:39


Video 2
Title: Basic Tutorial: Use word to create a visually appealing document
Video Link: https://youtu.be/dtRktYL5xko
Source: Professional Selling
Time taken to watch the video (minutes: seconds): 15:43


	CASE 1:
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	1. Read the case scenario below on document design and apply them to create visually appealing documents
2. Write your notes to summarize what you have understood from the case scenario. These notes will guide you in responding to the questions after the case.
3. Respond to the questions after the case
4. Each question carries one point
5. Upload your answers to the LMS.
6. Each answer you  give should not exceed twenty (20) words

Case Scenario
Assume you work as a graphic designer at a marketing agency, and you have been assigned the task of creating visually appealing documents for a client's upcoming product launch. The documents include a product brochure, a sales presentation, and a social media flyer. Your goal is to design these documents in a way that they are visually appealing, eye-catching, and effectively convey the key messages and branding of the product.
1. After reading the case scenario, answer the questions below.
2. The write-up of your answers should not be more than 200 Words
3. Upload the write-up of your answers on to your E-Portfolio on  the LMS 

Questions
1. Explain how you can create a consistent theme and style across all documents to maintain branding?
Explain how you can create an effective layout for the social media flyer?
2. Explain how you can effectively use typography to convey key messages in the sales presentation?


	[bookmark: _Hlk131239802]ACTIVITY 5: READING MATERIAL 
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	1. Click the link below to access the reading material on document design and apply them to create visually appealing documents.
2. Summarize the read material and post it on the blog. 
3. The write-up should not be more than 500 characters.
4. Upload the write-up on the LMS 

Title: Make it Visually Appealing
Link: https://www.nedarc.org/tutorials/utilizingdata/adoptGoodCommPrinciples/makeItVisuallyAppealing.html


Designer: Download and make the reading material accessible to learners. 


	ACTIVITY 6: ONLINE DISCUSSION
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	1. Join and participate on this discussion forum document des
2. Form groups of five learners
3. Select one data entry tasks or scenario from the list provided below
4. Identify the most appropriate computer input device to use for the above selected scenario, considering factors such as the type of data, input speed, accuracy, ease of use, and ergonomic considerations.
5. Present  your rationale for the selected input device, and discuss on the pros and cons of different input devices for specific data entry tasks
6. Ensure you post your discussion on the forum and critique at least two posts posted by other learners.
7. Your answer should be brief and to the point, not more than 50 words per answer
8. This activity will be graded.

Discussion Questions
1. How can you effectively use themes and templates in Microsoft Word to create visually appealing documents?
2. How can you effectively use headers and footers in the documents to enhance their visual appeal?

Designer: Create a discussion forum and Provide a mechanism to award points to those who participate in this discussion. Award  five points for participation


	 LEARNING OUTCOME 3: PRACTICAL SKILLS
VIDEO 3: 
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	1. Click the link below to watch the two videos on document design and apply them to create visually appealing documents.

Video 1
Title: Creating A Professional Looking Word Document
Video Link: https://youtu.be/Yh3SFlK2j6A
 Source: Mark Allenby
Time taken to watch the video (minutes: seconds):  6:13

Video 2
Title: Basic Tutorial: Use word to create a visually appealing document

Video Link: https://youtu.be/dtRktYL5xko
Source: Professional Selling
Time taken to watch the video (minutes: seconds): 15:43


	
ACTIVITY 7: Learner practice sessions
	1. After watching the videos on how to create visually appealing documents with Ms Word, practice the skills learnt by performing the tasks below.
2. You require a computer installed with a word processor
3. You will be required to self-recorded yourself as you perform the tasks
4. Ensure you explain the activity as you conduct it
5. The self-recorded video should not exceed 60 seconds 
6. Upload the self-recorded video showing you, performing the tasks to your E-Portfolio
7. This activity will be graded.
Task
1. Create a Certificate of completion for yourself

	ASSESSMENT OF PRACTICAL SKILL:

	Marking scheme for the practical
· Award 5 points for good explanation and performing the task
· Award one point for following instructions


	LEARNING OUTCOME 4: KEY/TRANSFERABLE SKILLS
	Click the link below to access the reading material developing skills in visual communication, attention to detail, and creativity through designing visually appealing documents that effectively convey information

Title: Beautiful Documents
Link: https://cdn.windwardstudios.com/Website/WhitePapers/Beautiful-Documents.pdf

Title: How to Make a Certificate in Microsoft Word – Tutorial
Link: https://www.template.net/tutorials/make-certificate-in-word/


Designer: Make the reading materials accessible to the learner

	ACTIVITY 8
	1. This activity aims to demonstrate transferable skills in visual communication, attention to detail and creativity through designing visually appealing documents
2. You will require a computer with a word processor software
3. You are  required to carry out the tasks given below
4. The Activity is  timed and will be graded
5. Upload it to the E-Portfolio on the LMS

Task
Create a Certificate of participation in this module for yourself

	QUIZZ: 
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	1. Having watched videos, read reading materials, responded to a case study and performed practical exercise. 
2. Undertake the following quiz to test your knowledge and skills acquisition on this module.
3. This activity will be graded

Quizz

Match the terms on the left column to their corresponding descriptions on the right side column in the context of a word processor.




	Terms
	Description

	Headers
	Section at the top of a page that typically contains information such as page numbers, document title, or author name.

	Table of Contents
	An organized list of the headings or chapters in a document, along with their corresponding page numbers.

	Footers
	Section at the bottom of a page that often contains information such as page numbers, date, or copyright notice.

	Styles
	Sets of predefined formatting options that can be applied to text or paragraphs to quickly change their appearance.

	Themes
	Pre-designed formats that determine the appearance of a document, including fonts, colors, and formatting.

	Templates
	Pre-designed documents or files that serve as a starting point for creating new documents with consistent formatting and layout.

	Page layout
	Refers to the arrangement and formatting of text, images, margins, and other elements on a page in a document.





Marking Scheme
Designer: Each question carries one point. See marking scheme below. The learner is deemed to have completed the module successfully if he/she scores atleast 5out of 7
 
	Terms
	Description

	Headers
	Section at the top of a page that typically contains information such as page numbers, document title, or author name.

	Table of Contents
	An organized list of the headings or chapters in a document, along with their corresponding page numbers.

	Footers
	Section at the bottom of a page that often contains information such as page numbers, date, or copyright notice.

	Styles
	Sets of predefined formatting options that can be applied to text or paragraphs to quickly change their appearance.

	Themes
	Pre-designed formats that determine the appearance of a document, including fonts, colors, and formatting.

	Templates
	Pre-designed documents or files that serve as a starting point for creating new documents with consistent formatting and layout.

	Page layout
	Refers to the arrangement and formatting of text, images, margins, and other elements on a page in a document.





Designer: What is highlighted in red is the correct answer. Each question carries one point. If a learner does not get atleast nine correct answers then the learner should be referred back to watch the videos and re read the materials provided


	TAKE HOME MESSAGE
	On the blog, post your take home message about this module

	Reference list
	1. Lambert, J. (2023). Microsoft Word Step by Step. ISBN-13: 978-0137522729

2. Zeldovich, B. (2022). Microsoft 365 2023 Edition. ISBN: 979-8363221682
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